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Getting Started Checklist

Getting Started Checklist

There are many new features in Premier X13, and many existing features have changed. The following list
suggests steps you should take before migrating your files to Premier X13. More information about each
of these steps can be found after the list.

[ 1. Review the List of New and Improved Features by Chapter

There are a number of important reasons why you should familiarize yourself with the new and
improved features in Premier X13:

« New and improved features allow you to produce drawings more efficiently, so it is to your
advantage to use them.

« Some changes to existing functionality may affect your accustomed drawing style and thus
your productivity if you are not aware of them.

« New features may affect your choice of settings in your template files, as well as your pre-
ferred Preferences settings.

See New and Improved Features by Chapter on page 14.

[ 2. Review Migrating Legacy Content
Legacy users of Premier often have library catalogs and other custom content that they want to con-
tinue using. See Migrating Legacy Content on page 4.

[] 3. Review Migrating Legacy Settings
Before migrating Preferences, Toolbars, or Hotkeys, bear in mind that legacy settings may not be
best suited for using the new program version. See Migrating Legacy Settings on page 5.

[] 4. Review Migrating Legacy Templates

Before migrating Templates, bear in mind that they may not be set up to take advantage of new
tools in the new program version. See Migrating Legacy Templates on page 6.

[ 5. Review the Considerations for Legacy Files

Before opening a plan or layout file created in a previous version of Premier, be aware of potential
changes to the file that could occur in the new program version. See Considerations for Legacy
Files on page 7.

[] 6. Launch Premier X13

Once you have learned about the new features in Version X13 and decided whether to migrate any custom
settings from a legacy program version, launch Premier X13. The first time you launch, the Migrate Set-
tings dialog will give you the opportunity to bring legacy settings and content forward into Version X13.
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Migrating Legacy Content

Legacy users of Chief Architect Premier often have a wealth of library catalogs and other custom content
that they have built over time and want to continue using.

LEGACY LIBRARY CONTENT
There are several ways that legacy library catalogs can be brought into Chief Architect X13.

If you have Chief Architect version X5 through X12 installed on your computer, the Migrate Settings dia-
log will display after you activate the license, allowing you to migrate library content as well as a selec-
tion of other settings for use in Chief Architect X13. If multiple legacy versions are present on the system,
only the data associated with the most recent will be migrated.

You can import library files from Versions X1 through X5 at any time by selecting Library> Import
Library (.calib, .calibz) from the program menu.

In addition, library files from Versions 10 and prior can be imported by selecting Library> Convert
Legacy (.alb) Library Files from the program menu. Bear in mind, though, that older content may not be
of the same quality as currently offered catalogs and that legacy Manufacturer catalogs may be out of date.

CuUSTOM GRAPHICS FILES

Chief Architect can use graphics files regardless of where they are stored on your system; however, it is a
good idea to keep your data organized in one location. If you have custom graphics files, including tex-
tures, images or backdrops that you used in a previous program version, you can copy them manually
using your operating system for use in Chief Architect X13.

« Copy custom texture files to the Chief Architect X13 Textures folder located in the Chief Architect
X13 Data folder.

« Copy custom image files to your Chief Architect X13 Images folder located in the Chief Architect
X13 Data folder.

¢ Copy custom backdrop files to your Chief Architect X13 Backdrops folder located in the Chief Archi-
tect X13 Data folder.

In Chief Architect X1 through X12, custom graphics were saved in the Chief Architect Data folder, as
they are in version X13. In version 10, they were located in the program’s installation directory, in folders
that began with “My”. Custom backdrops, for example, were saved in “My Backdrops”.

Texture and image files are not listed in the Library Browser. These files can be assigned to material and
image objects, however, which are stored in the library so it is important to retain them. There are several
tools available for adding materials and images to the library.
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Migrating Legacy Settings
The Migrate Settings dialog lets you migrate settings from the most recent legacy installation of Chief
Architect Premier into Version X13. If you have extensively customized your Preferences, Toolbars, or

Hotkeys, you may want to continue using those settings. Before doing so, though, it is important to con-
sider that you may make it harder to take advantage of new tools and functionality in Version X13.

PREFERENCES SETTINGS

Although you can migrate your Preferences settings from Versions X5 through X12 into Version X13, the
settings that are available in Version X13 may differ from previous program versions. You should review
all the settings in the Preferences dialog to make sure that they are set to suit your drawing needs.

CUSTOM TOOLBAR CONFIGURATIONS

It is possible to migrate toolbar configuration files from previous versions to Chief Architect Premier X13;
however, it is also possible that your migrated toolbars will be missing new tools available in Version
X13.

We recommend that you set up your custom toolbars the way you would like them in Chief Architect
Premier X13. You may find it most effective to customize your toolbars as you get used to working in the
new program version, rather than beforehand.

CuSTOM HOTKEYS

Like toolbar configurations, legacy hotkeys can be migrated into Chief Architect Premier X13. Bear in
mind, though, that occasionally the default hotkeys are modified to accommodate new features or changes
in default system hotkeys.
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Migrating Legacy Templates
Chief Architect X13 installs a selection of template plan and layout files that have been set up to take

advantage of the program’s updated tools and features. Although you can migrate your template files for
use in Version X13, for best results it is recommended that you either:

« Use the installed templates when creating new plans and layout files in Chief Architect X13

o Use the installed templates as the basis for creating new custom templates.

If you choose to continue using custom template files that you created in a previous program version, it is
very important that you take the time to carefully review all the default settings in the file, making sure
that they will continue to suit your needs in Version X13. First, make copies of your custom templates in
the Chief Architect Premier X13 Templates directory. The Templates directory is located in the Chief
Architect Premier X13 Data folder. Next, open each template as you would a regular plan or layout file,
by selecting File> Open, and then save any changes you make by selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout template
from the same program version, as well. As with a template plan, take the time to go through the layout
template’s defaults and make sure they are suited for use in Version X13 and that their line weight scales
do not conflict with those in your template plans.
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Considerations for Legacy Files

As in all software, every new program version introduces changes to its functionality as well as to the user
interface. If you choose to bring a project forward, be sure to take a few moments to look it over in the
new version and confirm that the new functionality does not require you to make any modifications. Par-
ticularly if you have an approaching deadline, you may find it best to finish the current project in the ver-
sion of the software in which you began it.

. Be sure to read this section before opening any plans cre-
A ated in earlier versions of Chief Architect.

Chief Architect X13 can open the .plan and .layout files from prior versions. Files with the older .pl and
la file extensions are no longer supported, however, and cannot be opened by Chief Architect X13. Before
opening any files created in earlier versions of Chief Architect, it is important to be aware of changes
made in the newest version and the effect they may have on your legacy plan and layout files.

Please note that files saved in the latest program version cannot be read by older versions of the software.
When a legacy file is saved in the version X13, an unaltered copy of the original file is created in the
Chief Architect X13 Data folder, under Archives, which can still be opened in the original version.

FOR FILES CREATED IN VERSION X12 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version
X12 or prior, bear in mind the following:

1. Default 110V Ceiling Outlet

In Chief Architect X12 and prior, the 110V Outlet tool did not have the ability to place outlets in ceil-
ings. In Version X13, this ability was added, as was the new GFCI Outlet tool. When a legacy file is
opened in Version X13, the new Electrical Defaults settings for these items will automatically refer to
objects in the Version X13 Core Catalogs. You should confirm that these defaults meet your needs. If
these default objects are not present in your library, a warning message will inform you of the issue.

2. Sliding Door Hinge Side

In Chief Architect X12 and prior, the fixed or 'hinge' side of sliding doors was described as viewed
from the exterior side of the door. In Version X13, the hinge side is described using the more common
method: as viewed from the interior side. When a legacy file is opened in Version X13, all instances of
the %hinge side% Name-Value Pair in labels, schedules, and the Materials List will use the new
method. You should confirm that the Hinge Side information in labels, schedules, and Materials Lists
meets your needs.

FOR FILES CREATED IN VERSION X11 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version
X11 or prior, bear in mind the following:

1. Perspective Crop Mode

In Chief Architect X8 through X11, Perspective Crop Mode allowed older functionality governing
zooming in cameras from Version X7 and prior to be preserved in saved cameras in legacy plans
migrated forward. This deprecated tool has been removed from the program’s menu and toolbars in
Version X12, although it can be migrated with legacy toolbars and hotkeys. Saved cameras in legacy



Chief Architect X13 Migration Guide

plans with this behavior enabled may become distorted if you pan or zoom in the view. To per-
manently disable this behavior in a camera view and resolve the resulting distortion, select Window>
Fill Window or press the F6 key.

2. Layout Layer Sets
In Chief Architect X11 and prior, the Send to Layout dialog had a sticky Make Copy of Active Layer
Set option that created a new layer set for the layout view to help preserve layer settings in that view.
This option was removed in Version X12 to encourage use of the multiple saved plan views. Saved
plan views did not exist in Version X9 and prior, however, so if you open a plan originally created in
Version X9 or prior, extra care must be taken to make sure layout views do not use the same layer set.

3. Materials List Formulas and Ruby Macros
Name-Value Pairs returned length, area, and volume measurements as Floats. In Version X12, these
values are reported using the Measurement class that includes both a numeric value and a unit. Older
Ruby code may change behavior when migrated into Version X12. When a legacy Ruby macro or
materials list formula is evaluated, the program will automatically check its version and prompt you to
migrate it to the newest version.

4. Units of Measurement
In Chief Architect X11 and prior, units of measurement used by the program, including user-defined
units, were stored in a file called Units.dat located in the Chief Architect Data folder. Beginning in ver-
sion X12, this information is saved with other Preferences settings.

FOR FILES CREATED IN VERSION X10 AND PRIOR
In addition to the above recommendations, if you wish to open files created in Chief Architect Version
X10 or prior, bear in mind the following:

1. Marker and Elevation Point Heights
In Chief Architect X10 and prior, the # sign could be added to the label of a Marker or Elevation Point
and the label would report the height of the Marker or the Elevation Point’s elevation. In Version X13,
text macros are used to report this information instead. In legacy plans, any # signs in Marker or Elev-
ation Point labels will be replaced by the %heightf% or %elevationf% macro.

2. Glass Shower Walls
In Chief Architect X10 and prior, the “Glass Shower” wall type was included in installed template
files and like other wall types, built to the structural layer of floors and ceilings and to the Main Layer
of adjacent walls. In Version X13, this wall type has the new Partition Wall attribute and instead
builds to floor, ceiling, and wall surfaces. When a legacy file is opened in Version X13, this wall type
will be modified to have Partition Wall checked automatically and existing walls will be affected by
this change.

3. Fixture Schedules

In Chief Architect X10 and prior, 3D Elevations and Perspectives in Fixture Schedules showed cabinet
fixtures inserted into a cabinet. In Version X13, fixtures are shown on their own, even when they are
inserted into an object in the plan. When a legacy file is opened in Version X13, any fixture schedules
showing 3D views of objects may be affected by this change.

FOR FILES CREATED IN VERSION X9 AND PRIOR
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X9
or prior, bear in mind the following:
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1. Parallel Lights

In Chief Architect X9 and prior, Parallel Light sources could be specified for electrical light fixtures
and Added Lights. In Version X13, Parallel Lights are no longer supported. In legacy plans opened in
Version X13, any Parallel Light sources will be converted to Spot Lights.

2. Brick Ledges

In Chief Architect X9 and prior, brick ledges were not represented in plan view. In Version X13, brick
ledges are drawn in plan view on the “Slabs” layer in stem wall and grade beam foundations, and on
the “Walls, Foundation” layer in monolithic slab foundations. When a legacy file is opened in Version
X13, brick ledges, if present, will be drawn.

3. Window Types

In Chief Architect X9 and prior, the %type% text macro for windows reported some Window Types
using abbreviations. In Version X13, the abbreviations were replaced with full words. When a legacy
file is opened in Version X13, the width of Window Schedules may be affected, as may the width of
columns in saved Materials Lists.

4. Joist Direction Lines

In Chief Architect X9 and prior, Joist Direction Lines described all platform framing as “joists” and
used nominal lumber sizes in whole inches in US Unit plans. In Version X13, the platform’s framing
Structure Type is reported and in US Unit plans, the size is described in fractional inches. When a leg-
acy file is opened in Version X13, Joist Direction Lines will use the new, more accurate labeling.

5. Custom Schedule Columns

In Chief Architect X9 and prior, custom schedule columns could be created by adding a Sub Category
to a type of object on the Categories panel of the Preferences dialog. In Version X13, Sub Categories
can no longer be created in this manner. When a legacy file is opened in Version X13, any Sub Cat-
egories shown as custom schedule columns will be converted to Custom Fields.

6. Registered User Text Macros
In Chief Architect X9 and prior, a selection of Registered User Text Macros could be inserted into
Texts, Callouts, and Markers. These macros no longer displayed any data and in Version X13, they are
no longer recognized. When a legacy file is opened in Version X13, any Registered User macros inser-
ted into text objects are treated as regular text.

FOR FILES CREATED IN VERSION X8 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X8
or prior, bear in mind the following:

1. Layer Names

In Chief Architect X8 and prior, turning off the Modify Name in all Layer Sets option made it possible to
assign different names to the same layer in different layer sets. In Version X9, this option was no longer
supported. When a legacy file is opened in X13, the layer names used in the currently active layer set will
be retained and any other layer names in other layer sets will be discarded.

FOR FILES CREATED IN VERSION X7 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X7
or prior, bear in mind the following:
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1.

Boxed Eaves

In Chief Architect X8, improvements to the generation of Boxed Eaves ensure that they extend into
exterior rooms with “Use Soffit Surface for Ceiling” specified when located between the roof baseline
and an interior room. In some legacy plans opened in Version X13, the Length value for Boxed Eaves
may need to be modified in the Roof Plane Specification dialog.

2. Uppercase Text

The Uppercase option was added to Text Styles in Version X8, whereas in Version X7 and prior, it
was an option for Room Labels and Schedules only. In legacy plans opened in Version X8, any Sched-
ules present in the drawing will be assigned a Custom Text Style, as will their associated Schedule
Defaults. If any Schedule Default is set to Use Layer for Text Style and no objects are present on that
layer, a new Schedule Text Style will be created and assigned to that layer. Room Labels are treated
similarly: if any are present, they and their defaults will use a Custom Text Style. If a given Room
Label or Schedule has been sent to layout more than once and was set to use different Text Styles in
each layout view, it is possible that its appearance may be affected in some views.

FOR FILES CREATED IN VERSION X6 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X6
or prior, bear in mind the following:

1.

Built-in Appliances

In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base cabinets
had incorrect sizing data. In legacy plans opened in Version X13, these appliances will not fit into the
cabinet correctly and will need to be replaced. Built-in dishwashers are particularly affected.

2. Formatting of Bulleted and Numbered Lists

In Version X7, various improvements were made to the way lines of Rich Text are spaced. In legacy
plans opened in Version X7, Rich Text objects with bulleted and numbered lists may require adjust-
ments.

3. Chief Blueprint Font

The Chief Blueprint font was improved for Version X6, with decreased top and bottom spacing. The
change in spacing may increase the overall height of text objects using this font in X6 files opened in
Version X13. X5 and prior legacy files will not be affected by this change.

FOR FILES CREATED IN VERSION X5 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X5
or prior, bear in mind the following:

1.

Name-Value Pairs for Doors and Windows

In Version X6, the NVPs door_style name, door_type name, and window_type name were shortened to
style_name and type name. Any object labels or text macros using these NVPs in legacy plans opened in
Version X13 will need to be replaced.

FOR FILES CREATED IN VERSION X4AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X4
or prior, bear in mind the following:

10
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1. Roof Overhangs and Framing

In Chief Architect X4 and prior, roof overhangs were measured to the outside of the subfascia,
whereas in Version X5 and later, they are measured to the outside of the fascia or shadow boards, if
present. In legacy plans opened in Version X13, this will not affect the appearance of roof planes in
floor plan view because in X4 and prior, roof plane polylines represented the projected framing area
whereas in Version X13 they represent the total projected area. But, the position of the fascia and sub-
fascia will shift, as will the length of the rafters.

2. Door Swing Direction and Materials

In Chief Architect X4 and prior, exterior doors that swing outward display interior material on exterior
side of door. This was corrected in Version X13. Doors modified to work around the old behavior
could be affected in legacy plans opened in Version X5.

3. Door Swing Direction and Louvers

Improvements to door louver direction may affect louvers in all doors with the exception of bifold
doors .

4. Wrapped Door/Window Lintels and Window Sills

In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those that were not
wrapped. In legacy plans opened in Version X13, the extents of wrapped lintels and sills will be adjus-
ted so that they equal their Extend setting.

5. Cabinet Feet

The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork symbol
to insert into cabinets effectively. In Version X13, the offset is set in the Cabinet Specification dialogs.
When legacy plans are opened in Version X5, cabinet foot offsets are set to 0 and transferred to their
containing cabinet, if one exists. Any customized or independently placed cabinet feet will be affected.

6. Object Labels in Cross Section/Elevation Views

If a “Label” layer is turned on in a cross section/elevation view and objects of that type are visible in
the view, then those objects’ labels will display in that view when the plan is opened in Version X13.

7. Transparent Materials

In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing were visible
in rendered views even when their Index of Refraction was set to 1.0. When legacy plans are opened
in Version X13, Transparent materials with an Index of Refraction of 1.0 are transferred to the General
Material class and assigned a Transparency value of 100%. This will not affect these materials’ appear-
ance in ray trace views, but will make them completely invisible in rendered views.

8. Registered User Text Macros

In Chief Architect X4 and prior, a selection of Registered User Text Macros could be inserted into
Texts, Callouts, and Markers. These macros reported information that was provided when the program
was installed and registered on the computer. In Version X5 and later, the program no longer collects
registered user information. When a legacy file is opened in Version X13, any Registered User macros
inserted into text objects are treated as regular text.

9. Invisible Beams

The legacy Invisible Beam check box was removed from the Wall Specification dialog. When legacy
plans are opened in Version X13, any Invisible Beam walls will be converted to Invisible Walls.

11
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FOR FILES CREATED IN VERSION X3 AND PRIOR

In addition to the above recommendations, if you wish to open files created in Chief Architect Version X3
or prior, bear in mind the following:

1. Text Styles

The appearance of a number of objects that include text - including object labels, the North Pointer,
Sun Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can now be controlled
using Text Style. Their appearance may be altered somewhat in legacy plans opened in Chief Architect
X13.

2. Light Sources

The illumination created by light fixtures and Added Lights was improved in Chief Architect X13.
Lighting in legacy plans may appear noticeably brighter when viewed in version X13.

FOR FILES CREATED IN VERSION X2 AND PRIOR

If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the following file
management changes and structural enhancements:

1. Legacy file formats

Chief Architect9.5 and prior files were saved in .pl and .1a the file formats. These file formats files are
no longer supported and cannot be opened in version X13.

2. Material textures, images, and backdrops

Chief ArchitectX2 and prior installed with a catalog of library content, including a selection of mater-
ial textures, images, and backdrops. This library catalog is no longer installed with the program
because it is now available for download on-demand, so it will be possible to open a legacy plan in ver-
sion X13 and encounter numerous missing file warnings. To avoid this, we recommend using the
Export Entire Plan feature in the original program version to create a folder that includes the plan

and all associated textures, images, and backdrops before opening this file in X13. This tool is

renamed Backup Entire Plan in version X13.

3. Floor and ceiling finish thicknesses

In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and objects
such as railings, stairs, landings, cabinets, fixtures, and furnishings measured their Floor to Bottom
height from the subfloor. These objects now measure their Floor to Bottom height from the floor finish
surface by default, so it is possible that you may notice height changes for these objects - particularly
in saved, annotated cross section/elevation views.

4. Riser heights and landing thicknesses

The default Best Fit Riser Height for stairs that do not reach the next level has been updated from 9”
(225 mm) in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X13. This may affect the
riser heights of stairs, as well as the thicknesses of landings attached to those stairs.

5. Auto Adjust Height

The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust Height
check box. If a cabinet, fireplace, fixture, furniture, or other library symbol had Follow Terrain
unchecked in version X2 or prior and was located in a room with a floor height other than the default
for the current floor, then the object’s Floor to Bottom Height will change to equal that room’s floor
height. The object’s position in the model will not change, however.

6. Adjustable Thickness Walls

12
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In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a legacy
plan file is opened in version X13 and these wall types are detected, they are replaced by an updated,
non-generic wall type. Framed walls and Railings will also acquire 1/2” (13 mm) thick layers of sheet-
rock on each side. Railings that define a Deck room with Advanced Deck Framing Built will not

acquire sheetrock layers.

7. Stairwells defined by railings

Interior railings that used a generic, single-layer wall type drawn in older program versions will
acquire layers of sheetrock when the plan is opened in version X13. This can affect the appearance of
staircases where they join to a floor platform. To address this issue, select the railing and move it 1/2”
(13 mm) away from the top edge of the staircase.

8. Deck rooms
In legacy plans opened in Chief Architect X13, Deck rooms with Advanced Deck Framing built retain
the framing but have Automatic Deck Framing turned off by default. Decks with no Advanced Deck
Framing built are converted to Balcony rooms.

9. Material definitions and light sources
Settings in the Define Material dialog that affect materials’ appearance of brightness have been mod-
ified. The Ambient setting was removed, and the Diffuse setting for materials in legacy plans will be
set to 100% when opened in version X13.
The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified. Lights
using Soft Shadows in legacy plans will be set to use Medium quality. The Light Diameter of light
sources in legacy plans is capped at 4” (100 mm).

10. Structural Member Reporting
When a plan created in Chief Architect X2 or prior is opened in Chief Architect X13, Materials Lists
are set to calculate Total Linear Length. For a combination of linear length and piece count, select
Mixed Reporting in the Structural Member Reporting dialog.

11. Fill New Framing Members
In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief Architect
X13 it applies to the entire plan. As a result, it is turned off by default in legacy plans opened in ver-
sion X13.

13
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New and Improved Features by Chapter

The following is a list of new and improved features in Premier Version X13. Where possible, cross-ref-
erences to additional information has been provided.

FILE MANAGEMENT
o The Save and Save As commands are now available in Materials Lists.

« Auto Save files are now created for unsaved plan and layout files.

PROJECT MANAGEMENT
« New Construction Line || tool allows you to create a column grid for object alignment in plan and
cross section/elevation views.
o The Project Browser now has a preview window.
« New Find in Project option for schedules and Layout Tables in the Project Browser.

o Improved snapping and drawing order of Space Planner Room Boxes.

PREFERENCES AND DEFAULT SETTINGS
o The Width of the crosshairs can now be specified.

WINDOW AND VIEW TOOLS
« New Fill Window Selected Objects tool.

« The name of a saved plan view is now reported in its Plan View Specification dialog.

CREATING OBJECTS
o The Center Object edit tool has been added to the Copy/Paste edit toolbar.

DISPLAYING OBJECTS
o The default Layer Set for Materials Lists can now be specified.
o The Height of Herringbone fill patterns can now be specified.

o The obsolete Materials List attribute for layers has been removed.

EDITING OBJECTS

o The Convert Polyline tool can now be used to create a Custom Backsplash in cross section/elevation
views.

« New Only Apply Properties to Doors of Same Type option for Style Palettes.

« New attributes added to the Select Properties to Load/Match Properties dialog for walls, doors, win-
dows, and text.

CAD OBJECTS
« New Edit CAD Block {3 edit button.

« The Reverse Direction edit tool is now available for Splines.
« New Match Line Color option for arrowheads.
« The Center Object edit tool can now be used to center CAD objects in cross section/elevation views.

o New Reset to Defaults button in the Set Properties dialog for Style Palette objects.

14
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WALLS, RAILINGS, AND FENCING

New Material Layer settings in the Wall Type Definitions dialog.
Wall type definitions are no longer limited to ten layers.
New Horizontal Framing option for wall framing layers.

The Platform Intersection settings for walls that create standard or balloon framing have been
improved.

New Ignored by Hide Exterior Walls option in the Wall Specification dialog.
Wall Hatching now has a defaults dialog and can also be assigned a label.

The Object Eyedropper tool now works with walls.

Wall Hatching can now be copied and pasted.

Improved feedback when it appears that a wall's layers may be oriented incorrectly. See .

RooMS

New Crawl Space Room Type.

Rooms with a Ceiling Height of less than 48" (1200 mm) are now automatically excluded from the Liv-
ing Area calculation by default.

Room moldings can now be suppressed behind cabinets and architectural blocks.
The Room Type and Structure can now be specified when multiple rooms are selected.
The Rafter Width and on center Rafter Spacing for Tray Ceilings can now be specified.

The Living Area label can no longer be deleted: the Plan Check tool is no longer needed to generate a
new one.

DIMENSIONS

L]

Dimension line labels can now be rotated and when moved, will snap to their dimension line when
Object Snaps are enabled.

The default Angular Format of Angular Dimensions can now be specified.

Manually drawn dimension lines in cross section/elevation views can now locate cabinet
Doors/Drawers/Panels and Openings, including the openings associated with front appliances.

Dimension lines can now locate Wall Steps.
New Display Wall Widths option in the Dimension Line Specification dialog.

New Auto Mark Centerlines option adds the Centerline mark to any extension lines that locate object
centers or midpoints automatically.

Automatic Dimensions now have multiple saved defaults.

New option to display dimension numbers in inches only rather than formats that use feet when less
than or equal to a specified value.

The Locate Objects settings can now be set independently for different manual and automatic dimen-
sion tools.

The Auto Dimension Defaults for all tools except Auto Story Pole Dimensions have been consolidated
into a single Dimension Defaults dialog.

When selected, dimension lines drawn with the Interior, Centerline, Baseline, and Running Dimension
tools are now described as such in the Status Bar.

The obsolete toolbar buttons and hotkeys for most Auto Dimension Defaults have been removed from
the program.

15
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The Auto Elevation and NKBA Auto Elevation tools now share the same Position settings.
The Interior Dimension tool can now be set to locate objects besides walls.

New Inner Dimension option allows you to suppress the inner dimension strings created by the Auto
Exterior Dimension tool.

New Top of Wall mark for automatic dimensions in elevation views locates the tops of vaulted walls.

Temporary Dimensions now always generate when toggled on, regardless of whether dimension lines
already locate the selected object.

TEXT, CALLOUTS, AND MARKERS

Text objects can now be added to the library without first including them in a CAD Block.

DOORS AND WINDOWS

L]

Wall Niches now have automatic labels.

Wall Niches can now be placed in pony walls with railings.

New Opening Indicators settings for doors, windows, and cabinets.
Opening indicator arrows can now display on sliding doors and windows.

The direction of Opening Indicators in Vector Views can now be set in the Plan Defaults dialog
instead of the Preferences dialog.

New setting for opening indicator direction in legacy files in the Preferences dialog.

Interior doors now retain their attributes when copy/pasted placed from the Library into an exterior
wall.

Style Palettes can now be used to apply attributes to the components of Bay, Box, and Bow Windows.
New Header Placement settings and a Combine Headers option for doors and windows.

The %hinge side% NVP for sliding doors now describes the fixed side as viewed from the interior
instead of the exterior. For information about how this change affects legacy plans, see For Files
Created in Version X12 and Prior on page 7.

New Bottom Sill options for door and window framing.

CABINETS
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A selected top-mounted cabinet fixture now has both the Open Object and Open Symbol edit tools.
New "None" Side Type creates a totally blank cabinet side or back.

New Top/Bottom settings control whether a cabinet has top and bottom surfaces.

Left and Right Stile width can now be specified for each Framed cabinet side independently.

Left and Right Reveal can now be specified for each cabinet side independently.

The Generate Custom Countertop edit tool now applies a selected base cabinet's non-default counter
material to the new countertop rather than applying the default counter material.

New Auto Door Threshold setting controls when Auto Left and Auto Right cabinet doors switch
from single to double.

Door and drawer Front Height and Front Width values are now reported for reference in the Cabinet
Specification dialogs.

Automatic countertop overhangs are now clipped and toe kicks suppressed on any cabinet side posi-
tioned near a Partition or free-standing appliance.

New Molding on Selected Edge options for Custom Countertops.
New Offset Molding For Face Items option for cabinet moldings.
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The Cabinet Filler tools are now listed with the regular Cabinet tools in the menu and toolbars for
easier access.

Interior and exterior cabinet materials can now be listed separately in schedules.

A cabinet's bottom Separation can now be resized past the bottom of the cabinet itself.
A cabinet's left and right stiles can now be extended to produce fillers.

Corner pilasters now generate a clipped cabinet corner in plan view.

New Edit button in the Cabinet Specification dialog opens the specification dialog for a selected fix-
ture inserted into the cabinet's front.

ELECTRICAL

New GFCI Outlet {; tool.
New Change to GCI Outlet {}; and Change to 110V Outlet edit tools.

The 110V Outlet tool can now be used to place ceiling outlets in Garage and Slab rooms in plan

view; in camera views, it can place ceiling outlets in all room types.

Electrical objects can now be group-selected by type when the drawing tool used to create them are act-
ive.

The Set as Default edit tool is now available for Rope Lights.

The deprecated Casts Shadows setting for light fixtures and light sources has been removed from the
program.

SCHEDULES AND OBJECT LABELS

Object labels can now be placed on custom layers.

The Schedule Start Number for each schedule can now be specified.

New Display Border option for object labels.

The Alignment of object label text can now be specified.

New "Total Length" column for walls, moldings, and roof trim in schedules.

Free-standing cabinet doors, Millwork, Hardware, and Geometric Shapes can now be included in
schedules.

Moldings assigned to cabinets, rooms, and other objects can now be included in schedules.
Frieze, gutters, and other Roof Trim can now be included in schedules.
The text associated with a selected schedule can now be exported to .txt, .csv, and .xml.

Interior and exterior cabinet materials can now be listed separately in schedules.

FOUNDATIONS

L]

New Slab Defaults and Slab with Footing Defaults dialogs.

Foundations with a Basement Ceiling Height of less than 48" (1200 mm) are no longer included in
the Living Area.

The Minimum Garage Height setting in the Foundation Defaults dialog no longer includes a sill plate
measurement.

ROOFS

Roof Planes and Skylights can now be listed in schedules.

Purlins can now be generated for Roof and Ceiling Planes.
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The Convert to Plain Polyline edit tool is now available for Roof and Ceiling Planes.

FRAMING AND TRUSSES

Wall, roof, and floor/ceiling platform layers no longer have to be assigned a Framing material in order
to generate framing.

The Roof and Floor/Ceiling Truss Specification dialogs now have an object preview pane.
New Roof Purlin ) tool.

End Profiles can now be specified for joists, beams, and General Framing members.

New Allow Automatic Balloon Framing option in the Build Framing dialog controls how wall fram-
ing adjacent to Open Below rooms is generated. Uncheck this to generate plates and rim joists instead
of balloon framing when wall framing is built.

The Reflect About Object edit tool is now available for Joist and Roof Blocking.

Wall corners and intersections can now be framed using reduced stud and laddered connections.

A Roof Truss drawn over a Full Gable Wall now has End Truss and Reduced Gable checked auto-
matically.

The Build Framing for Selected Object edit button is now available for Tray Ceiling Polylines and
trusses.

TRIM AND MOLDINGS

New Replace Molding ‘¥ tool.

New Type setting for cabinet moldings which is reported in schedules and the Materials List.
New Molding Specification dialog has OBJECT INFORMATION and SCHEDULE panels.
New Profile Rotation setting lets you specify a specific angle for molding profiles.

New Reflect Horizontal and Vertical options for molding profiles.

THE LIBRARY

The Library Search now supports Boolean keywords: AND, OR, NOT, as well as parentheses.
New symbols, line styles, fill styles, and backdrops can now be added to the library from the Select
Library Object dialog.

New Copy to User Catalog option in the contextual menu in the Library Browser.

New Duplicate option in the Library Browser allows you to copy an item in the User Catalog and
immediately paste the duplicate in the same location.

Update Library Catalogs & is now available as a button at the bottom of the Library Browser side

window.

When multiple identical objects are added to the library, only one instance is now created in the User
Catalog.

The obsolete Remove Manufacturer Lock edit tool for some library symbols has been removed.

CUSTOM SYMBOLS
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New option to automatically regenerate a 2D CAD Block for a symbol object when it is resized using
its edit handles in plan view.

New Progress dialog for lengthy Convert to Symbol operations provides an option to Cancel.



New and Improved Features by Chapter

OTHER OBJECTS

The Convert to Plain Polyline, Convert to Spline, Fillet Lines and Chamfer Lines edit tools are
now available for 3D Box and Shape objects.

Polyline Solids now have a defaults dialog.
The Shape Specification dialog now has Size, Elevation, Rotation, and Fill Style settings.
Holes in Shape objects can now be rotated as well as deleted independent of their containing object. .

The Fillet Lines and Chamfer Lines edit tools are now available for 3D Box and Face objects.

MATERIALS

L]

New Copy Selected Material s3i option for the Material Painter.

The "Air Gap" Material Structure Type has been removed from the program.
The Plan Materials dialog is now searchable.
New scoping modes for the Adjust Material Definition tool.

The Status Bar now reports information about materials highlighted when the Adjust Material
Definition tool is active.

New Add to Library button in the Define Material dialog.

The Select Material dialog can now be opened by double-clicking on a line item on the Materials panel
of various specification dialogs.

The obsolete Toggle Textures tool has been removed from the program.

3D VIEWS

L]

New Show Color and Show Watermark options in the Camera Specification dialog.
New Scene Clipping options for cross section/elevation views.

Wall Elevation views can now include or ignore walls located on the floor above: for example, the
gable walls associated with cathedral or vaulted ceilings.

Overview cameras now ignore the terrain when determining their initial position.

The right mouse button can now be used to temporarily activate Mouse-Tilt Camera mode while
Mouse-Orbit Camera mode is in use.

New Framing Overview Defaults dialogs.
Cross section/elevation views can now be copied and pasted.

The Auto Adjust Default Glass Properties setting no longer applies to door and window glass and was
renamed to Auto Adjust Electrical Default Glass Properties.

Obsolete View Types with Colors On settings removed from the 3D View Defaults dialog.

The deprecated Casts Shadows setting for Sun Shadows has been removed from the program.

3D RENDERING AND RAY TRACING

New GPU Ray Tracing in Physically Based and Clay renderings on Windows systems.
New Clay Rendering Technique.

New Line Drawing on Top options for Standard, Physically Based, and Duotone Rendering Tech-
niques.

The obsolete Update View button was removed from the PHYSICALLY BASED panel of the Rendering
Technique Options dialog. See .
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PICTURES, IMAGES, AND WALKTHROUGHS
o New Walkthrough Preview side window.
¢ New Create Orbital Walkthrough Path tool.

o A camera view of a single frame of a Walkthrough Path can now be created.
« Rendering Technique, lighting and more can now be set in the Walkthrough Path Specification dialog.
o The Backdrop image can now be set in the Walkthrough Path Specification dialog.

o A Walkthrough Path's Duration Along Path and Frame Rate can now be set in the Walkthrough Path
Specification dialog.

« Walkthrough Path Key Frames are now easier to select, have their own edit handles, and the selected
Key Frame in plan view is also selected for editing when the Walkthrough Path Specification dialog is
opened.

o New Delete Key Frame #£ edit tool for Walkthrough Paths.

o The Start and End Key Frames of a Walkthrough Path can now be deleted provided that at least two
Key Frames remain.

o The Add Key Frame &/ edit tool now has Sticky Mode X .

o New Key Frames now have height and angle settings basing on those of adjacent Key Frames.

« The Reverse Direction |« edit tool is now available for Walkthrough Paths.
o The Complete Break =5 edit tool is now available for Walkthrough Paths.

o The obsolete Edit Key Frames button for Walkthrough Paths was removed from the program.

¢ The Record Walkthrough Along Path edit tool is no longer available for plain CAD polylines and
splines.

o The settings in the Export Picture dialog are now retained between program sessions.

IMPORTING AND EXPORTING
« New warning allows option to cancel import of extremely large 3D symbols.
o Added support for AutoCAD® version 2021 file import and export.
o Added support for SketchUp version 2021 file import and export.

TERRAIN

o Terrain Paths now have separate Terrain to Top and Thickness settings, and their materials are cal-
culated in the Materials List.

¢ The Terrain Path Specification dialog now has a COMPONENTS panel and an object preview pane.

« Elevation Lines, Splines, and Regions now have Automatic Labels.

ROADS AND SIDEWALKS

« Roads now have separate Terrain to Top and Thickness settings, and the material assigned to the
"Road" component is calculated in the Materials List.

o The Road Specification dialog now has a COMPONENTS panel and an object preview pane.

PLANTS AND SPRINKLERS

o Sprinklers can now be listed in schedules.
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MATERIALS LIST

The "automatic count" macro used in the Materials List and on the COMPONENTS panel has been
replaced by formulas that illustrate how Materials Lists counts are calculated.

New Revert To Default 37 option for a selected Materials List cell resets its value to the originally

generated formula or information.
Each saved Structural Member Reporting default now has one reporting method and its own board list.

New Buy List Options for Long Board Runs settings improve upon and replace the Consolidate
Unhandled Boards options in the Structural Member Reporting dialog.

Prices can now be added to the Board Lists for Buy List and Linear Length Structural Member Report-
ing methods.

New Layer Set, Structural Member Reporting, and Reporting Method options in the Materials List
Specification dialog.

Materials Lists created using the Calculate Structural Materials for Deck edit tool now include

accessories added to the deck room.

To Revert all Line Items to Defaults 3 option on the Components panel of various object spe-

cification dialogs resets any customized formulas values.

Materials Lists using the Linear Length Reporting Method no longer include length information in the
Size column.

Thermal envelope information is no longer reported in the Materials List.

LAyouT

L]

The Send to Layout dialog now preserves the 'Send Options' and 'Camera View Options' settings for
different view types last used within the same session.

The Delete Objects dialog is now available in layout.

Plan file name and view information for a selected layout box is now reported in the Status Bar. .

RUBY IN CHIEF ARCHITECT

New Name-Value Pairs for objects including CAD lines and arcs, walls, doors and windows, and elev-
ation lines, splines, and regions.

New Name-Value Pairs for Text Style as well as individual style attributes.
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